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Document Indexer Overview 
Eclipse Document Indexer is the Windows portion of the Document Imaging companion 
product. Document Indexer works with Eclipse Document Imaging to organize, manipulate, and 
attach documents to Eclipse records.  

Click the displayed files in Indexer to view the documents or scanned images, and add 
annotations as needed. You can perform the following tasks in Document Indexer: 

Learn about Document Indexer 

• Learn how to use the Indexer menus and buttons. 

• Learn how to use the Image toolbars. 

Change Settings 

• Change Indexer settings. 

• Change annotation properties. 

• Change users. 

Use Document Indexer 

• Use index profiles. 

• Stack and unstack images. 

• Attach a scanned image to an Eclipse record. 

• Use Auto Attach to index scanned images automatically as you scan. 

Index Barcodes 

• Understand how to index by barcode. 

Tips on Images and Scanners 

• Understand image file types. 

• Understand scanner basics. 

Install Scanner 

• Install the Visioneer scanner. 
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Installing the Eclipse Document Indexer 
Perform this installation for any PC that you will use to access scanned images to attach to 
Eclipse records. This installation includes the Eclipse software for Windows that is necessary for 
file attaching and indexing. 

Eclipse Document Indexer is Windows software, licensed for image scanning workstations. Use 
this software to scan and manipulate document images, and index them to your Eclipse records. 
Also use the Document Indexer to view, copy, print or fax the scanned images. 

Minimum requirements for installation: 

• A Windows computer with a 166 MHz processor and 32 MB of RAM memory, 200 MHz 
or faster processor and 128 MB of RAM memory recommended for imaging 
workstations.  

• 40 MB of free hard disk space for program files (100 MB of free hard disk space 
recommended for caching images). 

• Eterm version 4.00 or greater for full use of all the imaging features. Sacrificing some 
features, Eterm 3.4 is the minimum usable version for Eclipse Document Imaging. Check 
your version number by starting Eterm, and choosing About from its Help menu. If you 
need to update Eterm, you can do so from the Eclipse Document Imaging installation 
CD-ROM. 

• (Optional) VSI-FAX® Gold Series Windows Network Client Interface software for faxing 
file images. 

The Attachment Viewer software, used to view and print image attachments, must be installed 
separately. Install the Attachment Viewer before or after installing the Document Indexer. 

To install the Eclipse Document Indexer: 

1. Verify that you have installed the software for your scanner. Consult the documentation 
with your scanner and install any scanner software necessary. If you are using an ISIS 
scanner, you normally only need to install the ISIS driver software. 

2. Download the current Eclipse software from http://distribution.activant.com/eclipse-
support. 

3. Select and run the Eclipse Document Indexer installation. Use all the default installation 
options. 

Installation creates a folder on your computer to store images. By default, this storage 
directory is created on the same hard drive as your Windows system software. The 
folder's default path and name is C:\InBasket. 

See Also: 
Document Indexing Overview 
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Installing the Visioneer Scanner Software 
The Eclipse Document Indexer and Document Imaging software must be installed before the 
scanning software is installed. 

To install the Visioneer software: 

1. Insert the Visioneer PaperPort CD-ROM.  

The installer program should start automatically, or you can double-click its Start.exe 
icon. 

2. Eclipse Document Imaging requires the Deluxe upgrade to the Visioneer software. Use 
the installer program to purchase this upgrade, by telephone or online. Install this instant 
upgrade according to the Visioneer directions. 

3. Follow the on-screen directions for the PaperPort Deluxe install option, and use any 
default settings. Consult the scanner documentation for assistance. During installation, 
you are asked for the serial number on the CD-ROM sleeve. 

See Also: 

Connecting the Visioneer Scanner 

Calibrating the Visioneer Scanner 

Document Indexing Overview 
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Connecting the Visioneer Scanner 
You can use many different scanner models with Eclipse Document Imaging, so consult your 
scanner documentation for the complete setup and installation directions. However, as some 
early Eclipse Document Imaging users still use older Visioneer PaperPort scanners, condensed 
general instructions for these scanners are provided. 

We recommend shutting down your computer before connecting devices such as scanners. 

See Also: 

Calibrating the Visioneer Scanner 

Installing the Visioneer Scanner Software 

Document Indexing Overview 
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Calibrating the Visioneer Scanner 
Once the PaperPort Deluxe software is installed, use the supplied calibration page to 
automatically adjust for the best possible image quality. Insert the wider edge of the calibration 
page into the scanner. When the calibration is complete in about a minute, withdraw the page and 
click OK. Calibration should take only about a minute. 

Notice the button on the scanner. Pressing this opens the scanner's preferences dialog box. 
Eclipse uses the Faxing, Filing, or Copying scan settings and defaults. The PaperPort scanner 
has no on/off switch; simply insert a sheet of paper, facing up, to begin scanning. Paper sizes 
from 2" wide to 30" long may be used in the scanner. 

Follow these guidelines when setting scanning option settings for Image Indexing: 

• For scans of most business documents, set your scanning software for binary black & 
white (1 bit) scans at a resolution of 200 dots-per-inch (dpi). 

• For scans of barcodes, set your scanner software for binary black and white (1 bit) scans 
at 600 dots-per-inch (dpi) resolution. 

• Scanning at a higher bit-depth or resolution than necessary wastes storage space, and the 
increased memory demands slow your computer's performance. 

• Save images using *tif (TIFF, or Tagged Image File Format) with CCITT Group 4 
(Consultative Committee for International Telegraph and Telephone) compression 
settings if you can specify these settings for the scanner. This format can be faxed. 

• Set the default format for new item title to any date format without a comma (Edit / 
Preferences / Item Names tab). For example, 11-19-2002. 

See Also: 

Installing the Visioneer Scanner Software 

Connecting the Visioneer Scanner 

Document Indexing Overview 
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Selecting Users 
User preference settings let you save, recall, and apply entire sets of Document Indexer and 
scanning preferences. This feature is handy if numerous people share a computer, or if the same 
computer is used for different types of scanning tasks. 

You can create a user preference setting named for different users or scanning jobs. For example, 
the user setting named "Invoices" might set the Document Indexer for Full Page Layout display, 
with a thumbnails display setting of Optimize, and scanner settings of 200 dpi in black and 
white. The user setting named "HR Dept" might be set to make 96 dpi color scans of personnel 
portraits, use a thumbnail display type of Normal, and configure the screen display using the 
Document Indexer's Alternate Layout. 

When you select a user, all the preference settings the user last used are immediately applied. 
The settings that get applied include annotation settings, scanning settings, view and window 
settings, and so forth. 

This page contains the following procedures: 

• Creating a new user 

• Selecting an existing user 

• Deleting a user 

To create a new user: 

1. In Document Indexer, from the Tools menu, select Switch Users to display the Select a 
User or Enter a New Name dialogue box. 

When you create a user, all the current settings for the Document Indexer are used. So if 
you already have a user preference setting that is similar to the desired settings, start by 
selecting that existing user. Then with those settings already applied, create a new user 
and change only the necessary options. Any options changed while a user is selected are 
automatically saved with that user’s preferences.  

2. Enter a name that fully describes the person or the particular scanning task, for example, 
"Scan Barcodes." 

3. Click OK to display the new user with the current settings. 

To select an existing user: 
1. In Document Indexer, from the Tools menu, select Switch Users to display the Select a 

User or Enter a New Name dialogue box. 

2. Click the drop-down menu to select the desired user from the list. 

3. Click OK.  

All the preference settings for the selected user are immediately applied. Any changes 
you make while that user is selected are remembered, and reapplied the next time that 
user is selected. 
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To delete a user: 

1. In Document Indexer, from the Tools menu, select Switch Users to display the Select a 
User or Enter a New Name dialogue box. 

2. Click the drop-down menu to select the user you want to delete. 

3. Click the Delete User button.  

4. Click Yes when asked to confirm that you want to delete the user. 

Note: The Default User preferences are chosen if you have not created and 
selected any other users. You cannot delete the Default User. 

See Also: 

Document Indexer Overview 
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Using Indexer Menus 
Use Document Indexer menu commands to control imaging display, annotation, and other 
options. 

Under the following menus you can perform the following tasks: 

• File Menu – Update, attach, and scan images. 

• Edit Menu – Select, cut, copy, and paste scanned images. 

• Tools Menu – Display a list of scanned barcodes on an image, change user names, or 
create a new user, and adjust general, scanning, and annotation settings. 

• Window – Arrange the Image Indexer window to your preference. 

• Help Menu – Display Image Indexer on-line help. 

File Menu 
• Open – Browse for the folder in which you have images stored.  

• Attach – Attach an image to an Eclipse record. 

• Request Profiles – Add any new image profiles to the Indexing window's Select Profiles 
list. Profiles are created in Eclipse Document Profile Maintenance and are pulled into 
Document Indexer when you click the Request Profiles item. You must have a message 
source selected in Eterm. 

• Exit – Close the Indexer screen. 

Edit Menu 
• Select All – Activate all images and stacks in the Indexer window. 

• Un-Select All – Deactivate all images and stacks in the Indexer window. You can also 
unselect active images by clicking the blank portion of the window. 

• Cut – Remove the selected image from the Imaging window and places it on the 
clipboard. 

• Copy (Ctrl+C) – Copy the selected image to the clipboard. 

• Paste – Inserts the image from the clipboard in the designated directory. 

Tools 
• Show Barcodes (Ctrl+B) – Display a list of barcodes that have been scanned in from the 

activated image. 

• Switch Users – Enter a different user name or create a new user name. Indexer displays 
the user's default folder of images. 
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• Options – Display the Document Indexer Settings dialogue box, where you set up the 
following properties: 

• General – To set Indexer startup, image viewing, and barcode options, as well as 
designate stacking and separator page options. 

• Annotations – To set the default line color, fill color, back color, and font properties 
for annotation tools. 

Window 
• Tile Horizontally – Display multiple open Indexer windows horizontally. 

• Cascade – Display multiple open Indexer windows overlapped in a cascade. 

Help Menu 
• Help Topics – Display Eclipse Document Imaging online help. 

• About Indexer – Display information about the Eclipse Document Indexer program, 
including the program's version number. 

See Also:  
Manually Attaching Scanned Images 

Using the Indexer Button Bar 

Using Image Tools 

User Selection Preferences 
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Using the Indexer Button Bar 
Use the Indexer toolbar buttons to quickly scan, attach, and stack images, adjust the image icon 
view, and change the Indexer screen content. The Imaging screen contains the following buttons: 

• Attach/Auto Att. – Attach scanned images to the designated Eclipse records. See 
Automatically Indexing Scanned Images for more information.  

• Select Profile – Clicking the drop-down menu displays the image profiles that have been 
created in Eclipse. Select the profile to display in Indexer. Profiles determine the storage 
location for the images. See the Eclipse Document Imaging Help for more information 
about profiles. 

• Use Barcode – Check this box to automatically read and process images based on their 
barcodes. See Automatically Indexing Scanned Images for more information. 

• Stack/Unstack – Combines separate scanned images into a single multi-page image. See 
Stacking and Unstacking Images for more information. 

• View – Select from the following list of display options for images in the Imaging 
window: 

• Large Icons 

• Small Icons 

• List 

• Details 

• Thumbnails 

See Also: 
Using Indexer Menus 

Document Indexer Overview 
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Using Image Tools 
Use the Image toolbar and annotation tools to save and print images, change the image display, 
and add your own annotations to images. 

The following table describes the toolbar buttons and their functions: 

Button Function 

 

Attaches the highlighted image to an open Eclipse record. 

 

Saves the changes to the current document.  

 

Displays a dialog box with printing options. 

 

Each click rotates the image 90°, clockwise. 

 

Each click rotates the image 90°, counterclockwise. 

 

Displays the previous page in a stacked image. 

 

Displays the next page in a stacked image. 

The following table describes the annotation toolbar, where you can change line width, color, 
and text properties. 

Button Tool 
Name Function 

 Selection 
Activates, moves, or resizes a selected annotation item within the 
scanned image. Click an item to activate it. Resizing handles display in 
the corners of an active item. Drag a resizing handle to resize the item. 

 Zoom Click and drag over the part of the image you want to enlarge. 

 
Draw an 
Arrow 

Click and drag to draw an arrow for pointing out detail on the image. 
Click positions the arrow's tail, and then release the mouse button where 
you want the head of the arrow. 

 Draw a Line Click and drag to draw an attention-getting line on the image.  

 
Draw 
Freehand 

Click and drag to create freehand pencil drawings. For example, to circle 
a name or number on the image.  
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Button Tool 
Name Function 

 Highlight Click and drag a highlight over an important area on the image. For 
example, highlight an invoice line item to make it catch your eye.  

 
Draw 
Redact 

Click and drag a black box over the part of the image you want blocked 
from view. For example, block part of the image that displays old 
pricing information. 

 Draw Text Click and enter text into an expandable text box on the image. Text 
boxes can be resized or moved. 

 
Draw an 
Ellipse 

Click and drag an elliptical line around part of the image. For example, 
circle an item on an image of a spread sheet that you want to stand out. 

 Box Click and drag to create a hollow rectangular box to draw attention to an 
area of the image. 

 Stamp  Imprint a customized stamp,  such as "Paid" or "Approved" on your 
image. Click on the image to place the stamp on that spot. 

See Also:  
Attaching Scanned Images 

Using Indexer Menus 

Document Indexer Overview 
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Changing General Document Indexer Settings 
You can change the Indexer startup, viewing, stacking, and  barcoding options. 

To change general Document Indexer settings: 

1. From the Document Indexer dialog box, select Tools, then select Options to display the 
Eclipse Document Indexer Settings dialog box. 

2. In the Indexer Startup section, check one of the following: 

• Show user selection screen at startup – Enter or confirm a user name when you 
start Image Indexer. 

• Start Indexer when Windows starts – Starts Document Indexer when you start 
Windows. 

3. Select one of the following Startup Modes: 

• Start Indexer in manual attachment mode – Defaults Document Indexer to manual 
attachment mode. 

• Start Indexer in auto attachment mode – Defaults Document Indexer to auto 
attachment mode. 

4. Select one of the following Image Viewing options for graphics files, such as .tif: 

• Use the built-in viewer for images – Displays images in Document Indexer's Image 
window, allowing you to use the annotation and attachment tools. 

• Use the registered file type viewer for images – Displays images in the default 
image viewer that comes with your Windows operating system. 

Note: Non-graphics files, such as Word documents (.doc) and Excel (.xls), 
display in their own programs, regardless of these settings. 

5. In the Barcoding section, check the box to display the Barcode Selection dialog box each 
time you attach an image that contains barcodes, allowing you to determine which 
barcodes to scan. 

Click and move the slider to the right to increase white space around a barcode on an 
image to as much as 1 inch. 

6. In the Stacking / Separator Page section, check the preferred stacking options: 

• Show config screen when stack/unstacking – To determine a new destination for 
stacked or unstacked documents, and to determine other stacking configurations. 

• Delete source images on stack/unstacking – To delete the individual images from 
the folder when they are stacked. The images re-display if you unstack the 
documents. For example, if you have five documents displayed, and you stack four of 
them, the window displays one stacked document displaying "4 pages" and one 
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unstacked image. The three images that combined with the first in the stack no longer 
display. 

• Use Separator Page when unstacking – To insert the separator page between an 
unstacked image and the next image to show where the stack ends and the next image 
begins. For example, if you open a folder containing only stacked images, when you 
unstack the images, the separator page displays between each unstacked set of 
images. 

See Also: 

Stacking and Unstacking Images 

Document Indexer Overview 
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Changing Annotation Properties 
You can change the default properties of new annotations. Depending on the type of annotation, 
you may be able to change its color, width, and font attributes. For example, there is no border 
width property for a highlight annotation, but there is for a hollow rectangular box. 

Use the Annotations menu commands to determine default annotation colors. These capabilities 
use your system's Color dialogue box, in which you can click to select a Windows basic color or 
a custom color. 

This page contains the following instructions: 

• Changing default properties for new annotations. 

• Changing text tool settings. 

• Creating and adding custom colors. 

To change the default annotation properties: 
1. Display the Annotations Default Settings dialogue box from one of  the following paths: 

• From the Indexer screen – Click the Tools menu, select Options to display the 
Eclipse Document Indexer Settings dialog box, then click the Annotations tab. 

• From the Image screen – Click the Tools menu, then select Annotation Options. 

The Annotations Default Settings dialog box shows the current settings that are applied to 
all new annotations. Color samples display next to their property names. Larger samples 
and the designated attribute font display in the Examples area.  

2. Click the following buttons to change annotations as needed: 

• Line Color – Applied to new straight or freehand lines, as well as the border lines of 
new hollow rectangular boxes. Select a color from the Color dialogue box, then click 
OK.  

• Highlight Color – Applied to fill the inside of new highlight annotations. Select a 
color from the Color dialogue box, then click OK. 

• Background Color – Applied to background of new text tool annotations, such as the 
Stamp Text tool. Select a color from the Color dialogue box, then click OK. 

• Font – Applied to new text tool annotations, such as the Stamp Text tool. Change the 
font size and style, effects, and color as desired, then click OK. 

• Line Width – Applied to new straight or freehand lines, as well as the border line 
around new hollow rectangular boxes. Click the drop-down menu to select the 
number of pixels for the line width. 

3. When you finish making changes to the default properties for new annotations, click OK 
to exit the Annotations Default Settings dialogue box. 
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To change text tool settings: 

1. In the Stamp Edit box on the Annotations Default Settings dialogue box, enter the text to 
display when you use the Stamp Text tool. For example, "Received" or "Paid." 

2. Click the Add Date button to include the current date in the stamped text. 

3. Click the Add Time button to include the time of day in the stamped text. 

4. Click the >> button to add the intended text to the Stamp Text tool. 

5. When you finish making changes, click OK to save the changes and exit the Annotations 
Default Settings dialogue box.  

To create and add custom colors: 

1. Click the Define Custom Colors button to expand the color dialog box, revealing a color 
matrix and controls. You can define the colors by entering HSL (Hue, Saturation, 
Luminance) or RGB (Red, Green, Blue) values, or by using the built-in color picker 
matrix. 

2. The Color|Solid preview window shows the current color. If your monitor properties are 
set to display only 256 colors, the preview window may also display a second dithered 
preview, which approximates how the color will be displayed using the limited number of 
colors available. 

3. Click the Add to Custom Colors button to make the color you defined available as a 
custom color choice. Click a custom or basic color choice to select that color. 

Note: The Color dialog box includes its own online help. For more information 
about using colors, click the dialog box's Help button (the "?" button), then 
click the area for which you want help. 

4. When you finish selecting colors, click OK to apply it to the next annotation. 

See Also:  

Using Document Indexer Menus 

Using Document Indexer Tools 

Document Indexer Overview 
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Stacking and Unstacking Images 
Stacking combines separate scanned images into a single multi-page image. Stacking is handy 
for combining invoices with a billing statement, for example.  

A stack of thumbnails is identifiable by the page count in the lower right of the stack.  

Stacking options are set up on the General tab in the Tools / Options menu. 

This page includes the following procedures: 

• Stacking images. 

• Unstacking images. 

To stack images: 

1. From the Indexer dialog box, select the images you want to stack.  

A blue border displays around the active images. 

2. Do one of the following to select images for stacking:  

• To select all images in this file, select Edit and click Select All. 

• To select several images in sequence, click and drag a marquee over the images you 
want to select. 

• To select individual images, press Ctrl while you click to select the desired images. 

3. Click the Stack button to stack the selected items. 

If you have the Show config screen when stack/unstacking option checked in Tools / 
Options, the Stack Images dialog box displays, allowing you to determine the names and 
destination of the newly stacked images. 

4. Add document annotations after stacking. When you stack documents, annotations are 
merged along with the documents. This results in color annotations being converted into 
gray, if the underlying image being stacked is grayscale. However, if you add annotations 
after stacking, the colors remain. 

To unstack images: 

1. Click to activate a stack as described above. A blue border displays around the stacked 
image. 

2. Click the Unstack button.  

If you have the Show config screen when stack/unstacking option checked in Tools / 
Options, the Stack Images dialog box displays, allowing you to determine the names and 
destination of the newly unstacked images. 
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Using Index Profiles 
Use index profiles to automate the indexing process. Index profiles are similar to templates, and 
let you apply a set of pre-configured index options. For example, a pre-configured profile can 
speed indexing by populating fields for you, or by eliminating unnecessary screens. When you 
select a profile in the Document Indexer's Profiles list, all the profile's settings are applied to the 
image, quickly and consistently. 

Index profiles not only improve efficiency, they also help you manage your imaging storage 
locations and security.  

Profiles are maintained in Eclipse and have two distinct parts: the document Profile ID, plus its 
associated Storage ID. The document Profile ID controls the overall index process, while the 
Storage ID controls the storage location. 

Once you understand how to use profiles, you can create your own. For more information, see 
the Eclipse Document Imaging documentation.  

See Also:  

Document Indexer Overview  
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Automatically Indexing Scanned Images 
Automate the indexing process by using Auto Attaching. When you enable Auto Attach, the 
Document Indexer runs in the background, and remains ready to automatically process images to 
the designated profile each time you scan a document. Automatic indexing is handy for 
processing large numbers of documents. 

You can also automatically index barcoded documents. 

To automatically index scanned images: 

1. From the Windows Start / Programs / Eclipse menu, select Document Indexer to display 
the Eclipse Document Indexer dialog box. 

2. From the Select Profile drop-down list select the profile for indexing your images. A 
profile is required to let the system know how to index and store the image being 
processed. This profile will be used for all the images during the auto processing session. 

3. Enter a directory path in the text box or click the Browse button to designate the 
directory path for the scanned images. 

4. Click the Auto Att. button. 

All files in the directory use the defined profile to attach to Eclipse records. 

5. Scan files as needed. Each file uses the defined profile until you click the Auto Att. 
button to disable auto attachment. 

See Also:  

Using Indexer Menus 

Attaching Scanned Images 

Using Index Profiles  

Indexing By Barcode 
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Attaching Scanned Images From Document Indexer 
Attach scanned images to Eclipse records to decrease paper filing and secure documents to their 
related Eclipse records. Keep track of all types of forms: 

• Invoices. 

• Credit applications. 

• Product photos or MSDS. 

• Signature captures. 

• Pick tickets, and more. 

To attach a scanned image: 

1. Display the Eclipse record to which you want to attach an image. 

2. From the Windows Start > Programs > Eclipse menu, select Document Indexer to 
start the Eclipse Document Indexer. 

3. Select a user. 

4. In the Select Profiles box, select the desired document profile. A profile is required to let 
the system know how to index and store the image being processed.  

For information about adding profiles, see Using the Indexer Button Bar. 

5. Select the document or documents you want to attach to the open Eclipse record. 

6. Click the Attach button to attach the image to the Eclipse record.  

Note: If you have a default profile set up for images and it is set to prompt on 
each index, you can use your Windows file management system, such as 
Explore, and click and drag the image file to the Eclipse record. 

The Eclipse Attachment Indexing screen displays. 

7. In the Description field, enter a descriptive name of the image. 

8. In the Index Points field, enter the following information, if needed. Use the Multi hot 
key to enter multiple items in each field: 

In the field... Enter... 
User ID additional pointers to User Maintenance records. 

Entity additional index pointers to Vendor or Customer Maintenance records. 

Ledger additional index pointers to any ledger records, including Sales Orders, 
Purchase Orders, and Accounts Payable. 

Product  pointers to product descriptions in Web Commerce. First set up a default 
profile for WOE-Images. We recommend naming the folder in the Internet 
ROOT directory the same as the profile. 
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In the field... Enter... 
Activity Log pointers to user and customer trackers. 

Product Cat  pointers to Eclipse Web Commerce product categories. This displays an 
image next to its product category on a web page, for example. For 
information about using product categories, see the Eclipse Web Commerce 
documentation. 

User Defined pointers to any custom user defined screens. For example, to index test 
reports to products, or reviews to employee screens. 

9. Use the following hot keys as needed: 

• Index – Indexes the file, removing the file from your computer to the storage 
location. 

• Index W/O Delete – Indexes the file, copying the file to the storage location without 
deleting the original file from your computer.  

• F12 – Closes the Delete/Edit Indexes screen without saving changes. 

The next time Eclipse displays that record, the record has an Image Indicator (*i*) in the 
top right corner to let users know an image is attached. 

Note: To permanently delete the attachment, manually remove it or run the 
Document Copy/Move/Delete Utility. 

10. Press Esc to exit the Eclipse screen. 

11. On the Indexer dialog box, select File > Exit to exit. 

See Also:  

Using Indexer Menus 

Using Image Tools 

Selecting Users 

Deleting or Editing Images in the Index 

Creating a Custom Indexing Profile 



Eclipse Document Indexer Rel. 8.6.3 (Eterm) 

22 © 2008  Activant Solutions Inc. All rights reserved. 

Scanning and Attaching Multiple Images of the Same 
Type 
As you do business, you might find it easier to scan a group of documents into the system 
together at one time, instead of scanning each document individually. For example, if you are a 
receiving clerk, you likely receive multiple vendor packing lists in any given day. Using 
Document Indexer, you can print barcodes of the Eclipse order number either on a cover page or 
a Zebra label and use those to speed up the process of scanning and attaching the vendor packing 
lists to orders in the system. 

Scanning and Attaching Documents Using Cover Pages 
Use the Document Imaging cover page that provides the system the barcode and order number it 
needs to attach the scanned image with a transaction. For each document you want to scan in a 
batch of documents, print the cover page from the transaction.  

To scan and attach documents using a cover page: 

1. From the System menu, select System Programming > User Defined Functions and 
then select the menu option that corresponds to the type of document you want to define.  

2. Define the cover page form. 

3. From the area of the system, such as a Purchase Order, use the Label hot key and print 
the plain paper form defined in step 2. 

For example, if you are scanning a batch of vendor packlists and attaching them to 
purchase orders, after you mark the purchase order as received, use the Label hot key to 
display the User Defined Document/Label Printing screen and select the cover sheet or 
plain paper form in the Doc/Lbl Format field. 

The system prints the plain form with a barcode and the order number that is specific to 
that order.  

4. Repeat step 3 for any additional documents you want to scan into the system at the same 
time. 

5. After you have cover pages for all the documents you want to scan together, stack and 
scan the documents in the following order: 

• Cover page for the first document. 

• All pages of the first document. 

• Separator page. You can print separator pages from Document Indexer. 

• Repeat for the other documents in the batch you want to scan. 

6. After the image displays in Document Indexer, select it and then click Unstack in the 
menu bar.  

7. Select Use Barcodes and then click Auto Process. 
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The system separates the documents using the cover pages and separator pages as 
markers, and automatically attaches the documents to the correct transactions in Eclipse, 
based on the barcode on the cover page. 

Scanning and Attaching Documents Using Zebra Labels 
You can also scan and attach a group of documents using labels instead of cover pages. Use the 
Document Imaging Zebra Label and place it either in the upper left corner of the document you 
want to scan or on a separate piece of paper.  For each document you want to scan in a batch of 
documents, print the label from the transaction. 

If the documents you are scanning contain other barcodes, we recommend that you use a cover 
page instead of a label. 

To scan and attach documents using Zebra Labels: 

1. From the System menu, select System Programming > User Defined Functions and 
then select the menu option that corresponds to the type of document you want to define.  

2. Define the Document Imaging Zebra Label. 

3. From the area of the system, such as a Purchase Order, use the Label hot key and print 
the label defined in step 2. 

For example, if you are scanning a batch of vendor packlists and attaching them to 
purchase orders, after you mark the purchase order as received, use the Label hot key to 
display the User Defined Document/Label Printing screen and select the Zebra label in 
the Doc/Lbl Format field. 

The system prints the label with a barcode and the order number that is specific to that 
order.  

4. Repeat steps 3 for any additional documents you want to scan into the system at the same 
time. 

5. After you have labels for all the documents you want to scan together, do the following to 
stack and scan the documents in the following order: 

• Attach the Zebra label for the first document to the first page of that document. 
Attach the label higher on the page than any other barcodes. If the Document Imaging 
Zebra Label is not the first barcode that Document Indexer reads, you will have to 
manually attach the documents to the correct transactions after you scan them into 
Document Indexer. 

• The remaining pages of the first document. 

• Separator page. You can print separator pages from Document Indexer. 

• Repeat for the other documents in the batch you want to scan. 
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6. After the image displays in Document Indexer, select it and then click Unstack in the 
menu bar.  

7. Select Use Barcodes and then click Auto Process. 

The system separates the documents using the labels and separator pages as markers, and 
automatically attaches the documents to the correct transactions in Eclipse, based on the 
information it reads from the Zebra label. 

See Also: 

Stacking and Unstacking Images 
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Barcoding Basics 
Use the following tips and techniques to improve barcode indexing: 

• For the most consistent barcode recognition, pay particular attention to the quality of the 
barcode printing. Always use a laser printer and good quality paper. Follow 
recommended printer maintenance; check and replace toner regularly. 

• Barcodes are readable horizontally or vertically, but not upside down, and can be placed 
almost anywhere on your forms. Page numbers or multiple barcodes, such as a second 
barcode for a description, are acceptable. 

• When designing forms for barcodes, tell your graphic designer to plan ahead. Keep 
barcode areas away from edges or perforations that can tear into barcodes. Leave lots of 
white space around bar codes. Keep barcode areas well away from signature sections on 
your business forms. A signature extending onto a barcode can render the barcode 
useless. Barcode formats 39 or 128 are often best. 

• Barcodes are not just for sales orders. You can create barcodes to use with other types of 
Eclipse records. For example, you can attach product data sheets to product records; start 
these barcodes with the PN# prefix to index with products. Standardize on using the 
following Eclipse barcode prefixes: PN# for product, CN# for entity, EL# for activity log, 
and USR# for user file. 

• White paper of good quality works best, as black barcodes stand out best against white. If 
you must scan colored paper, yellow paper may be better than pink or green papers. 
When scanning pink or other colors that result in nearly black scans, try photocopying the 
color documents, then scan the copies. 

• If you experience problems with your barcodes not being read, try scanning your 
documents a bit lighter. Scans that are too dark cause the barcode lines to fill in, making 
recognition difficult. 

Note: Print to a barcode printer from an open record by pressing Shift-F12, and 
selecting Print Barcodes. Select a barcode to print, press Esc. 

See Also:  

Indexing By Barcode 
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Indexing by Barcode 
If you purchased Eclipse's forms barcoding modification, you can further automate indexing by 
letting the Document Indexer search and index the images using their barcodes. 

This page include the following procedures  

• Automatically indexing barcodes. 

• Manually indexing barcodes. 

To automatically index by barcode: 

1. In Eclipse, from the System > System Files > Document Imaging menu, select Barcode 
Image Indexing to display the Image Indexing with Barcodes screen. This enables 
automatic indexing input into Eclipse, which continues until you press Esc to quit. 

2. From the Windows Start / Programs / Eclipse menu, select Image Indexer to start the 
Document Indexer. 

3. Select a user. 

4. Check Use Barcode to derive the index point information from barcodes in your 
documents.  

When this is enabled, the Document Indexer searches the images for barcodes, which 
Eclipse uses for auto indexing. Barcoded shipping tickets, for example, could be 
automatically indexed and input into Eclipse using this option. 

5. In the Select Profile drop-down list, select a profile to use for all images during the auto 
processing session. 

6. Scan the documents; they are automatically indexed to the designated profile.  

The message "Processing!" displays in the top of the Auto Indexing area during the auto 
processing session. Click the Cancel button to end auto processing. If Notify After 
Batch Process (Ctrl+P) is checked in the Options menu, the Image Indexer displays a 
dialog box when the batch is done processing; click OK. 

7. Run the Image Invoice Exception Report Image Invoice Exception Report from the 
Document Imaging program to verify that all documents were indexed properly. 

8. Manually index any exceptional documents remaining. See To manually index barcoded 
images below. 

If the Document Indexer is unable to read any barcodes, usually due to poor quality or 
obliterated barcodes, the documents remain in the designated directory.  

Note: When scanning batches of images using a scanner with an automatic 
document feeder, avoid mixing different document sizes. This can cause 
scanners to randomly stall, forcing you to restart the Document Indexer. 
We recommend batch scanning similarly sized documents. 
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To manually index barcode images: 

1. From the Indexer window, check Use Barcode. 

2. Select and open a document.  

3. Click the Attach button to display the Barcode Report window.  

4. Enter or correct the barcode information in the box. 

5. Click OK.  

6. Repeat as necessary for other documents. 

See Also:  
Barcoding Basics 
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Image File Types  
The most practical file types for Eclipse Document Imaging are:  

• TIFF (*.TIF) – The most practical file type for most imaging uses on a variety of 
computer platforms including Unix, Windows, and Mac OS. TIFF files permit 
compression to relatively small file sizes, important when storing numerous images. TIFF 
files can also be multi-page stacked documents. You can fax TIFF images when saved in 
a Binary format with CCITT Group 4 compression, or with the less desirable CCITT 
Group 3 compression. Because the images are faxable, Eclipse recommends using TIFF 
settings for imaging most business documents. 

• JPEG (*.JPG) – The Joint Photographic Experts Group file type is capable of heavy 
compression, making it popular for Internet and e-mail attachment use or for storing color 
images. Consider using JPEG files for employee or product photos, or when imaging 
documents used on a company intranet or the Internet. Choose the 24 bit Color or the 8 
bit Gray for black and white photos, formats to maintain a full range of tones, along with 
small file sizes, at the cost of losing some image data during compression. 

• ADOBE (*.PDF) –  The Portable Document Format, which requires Adobe's free 
Acrobat Reader program for viewing, is becoming a popular file type for exchanging files 
among different computer platforms including Unix, Windows, DOS, and Mac OS. If all 
of your users have Acrobat Reader software installed, you might consider this file type 
when you need to maintain high-fidelity graphics and text, along with relatively small file 
sizes. You may also encounter this file type when attaching existing Internet files, vendor 
materials, and documentation. You can get Acrobat Reader at www.adobe.com. 

• Windows Bitmap (*.BMP) – Though popular in Windows and DOS graphics 
applications, this file type creates large file sizes, making it less practical for imaging. 
BMP file size can be as much as ten times larger than the same image saved as a TIFF, a 
major consideration when buying storage devices. 

Some other file types are: 

• You can specify the CALS Files (*.CALS), FAX (*.DCX), JBIG Files (*.JBG), 
MO:DCA Files (*.MDA), Paintbrush (*.PCX), Calera (*.PDA), and Plexus TIFF (*.TIF) 
file types. These file types may be required for specialized graphics applications, but 
should generally be avoided for document imaging. 

Note: Windows 95 uses a Web browser or graphics program, instead of the 
Attachment Viewer, to enlarge GIF and some JPEG image types. 

• Portable Network Graphics (*.PNG) – An emerging graphics format designed for the 
Internet. At present it is not well supported, and should be avoided for most Eclipse 
imaging. 

See Also:  

Scanning Hardware Basics 
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Scanner Hardware Basics 
Some companies use a combination of the following hardware types to meet specific needs. The 
three common categories of scanner hardware installations are: 

• Individual scanners – Inexpensive desktop scanners are convenient if you scan single 
page documents frequently throughout the day, or scan confidential information. Personal 
scanners can also be practical for infrequent scanning of small stacks of documents. 
Typical users in this category are managers, and the credit or personnel departments. 

• Dedicated scanning workstations – Practical when an entire workgroup needs to scan 
documents, or when there is a frequent need to scan large batches, perhaps 25-50 pages, 
of documents at a time. If a networked computer with a scanner is dedicated for imaging, 
users throughout the company can use the workstation to scan as needed. 

If you use a central computer like this, you can set up personal folders on the workstation, 
and then save scans into these folders. Or instead, you can manually save images to a file 
server. Upon returning to your desk to index the images, you can access your imaging 
folders on the workstation or file server. Accessing images this way is even easier if you 
map a drive letter on your computer to the network computer or folder. Dedicated 
workstations are often used by Accounts Payable departments. 

• Network scanners – You can configure a document server to automatically route 
scanned documents to recipients. This solution requires a Windows NT network with 
sufficient available bandwidth, along with a device like the AXIS Network Document 
Server. 

A document server lets a company set up a Small Computer System Interface (SCSI) 
scanner with an IP (Internet Protocol) address on an Ethernet network. This solution 
requires that Microsoft Internet Information (IIS) server is running, and File Transfer 
Protocol (FTP) must be enabled and configured. The server can then be instructed to scan 
and route images to various folders on the network, or even e-mail images to recipients. 

When scanning a document or batch of documents, use the document server to select the 
recipients. Once scanning is completed, the documents are routed to the correct 
destinations, often network folders. This lets users access and index the images from the 
networked folders, for example. Network scanners are more automatic and convenient 
than dedicated scanning workstations, but they demand more network resources. 
Depending on the network's speed and configuration, network constraints may rule out 
this installation option. 

See Also: 

Image File Types 

Document Indexer Overview 
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